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About this release 
This document describes enhancements in ERDAS IMAGINE 2023 Update 1 (v16.8.1), including IMAGINE 
Photogrammetry (formerly LPS Core). 

ERDAS IMAGINE 2023 Update 1 is a full installer, meaning you can install it either on top of ERDAS IMAGINE 
2023 or on its own (i.e., there is no requirement to install, or uninstall, ERDAS IMAGINE 2023 first). 

Since ERDAS IMAGINE 2023 Update 1 is a full installer this document also describes all the new features 
introduced with the original release of ERDAS IMAGINE 2023 in the second half of the document. 

ERDAS IMAGINE 2023 Update 1 includes both enhancements and fixes. For information on fixes to customer 
reported issues that were made in ERDAS IMAGINE 2023 Update 1, see Issues resolved. 

This document is an overview and does not provide all details about the product's capabilities. See the product 
description, online help and other documents provided with ERDAS IMAGINE for more information. 

New features for Update 1 include:   

 

• Faster AI learning: Users can define an accuracy threshold; deep learning will cease its iterations 
with the model once the accuracy threshold is achieved 

• Updated Random Forest operator: Users can set the desired number of trees, enabling more robust 
models 

• Supporting Normalized Difference Red Edge (NDRE): Popular vegetation index enables users in 
remote sensing to measure the chlorophyll content to greater depths of the canopy in plants, which 
gives an indication of crop health, biomass, etc.  

• New Tabular Preview operator for tables and matrices: Users can quickly review results from the 
Spatial Model Editor 

• Additional Majority/Mode operator for generating thematic image pyramids: Images are 
enhanced, resulting in higher quality visualization when, for example, the user zooms out on the 
image 

• New format support feature for RPF products with multiple images: These now open as a mosaic 
for easier access 

• Support for DS-EO format: Imagery can be orthorectified using RPCs for quick and accurate 
georeferencing 

• Expanded On-Demand Data (ODX) support for features and point clouds: Overuse of valuable 
disk space is minimized; ODX was originally limited to raster data 

• Miscellaneous solutions to over 26 customer-reported issues 

  

https://bynder.hexagon.com/m/2afba20de2449e9d/original/Hexagon_SIG_ERDAS_IMAGINE_2023_product_description.pdf
https://bynder.hexagon.com/m/2afba20de2449e9d/original/Hexagon_SIG_ERDAS_IMAGINE_2023_product_description.pdf
https://doc.hexagongeospatial.com/


ERDAS IMAGINE 2023 Update 1 

2 April 2024  8 

ERDAS IMAGINE product tiers 
ERDAS IMAGINE performs advanced remote sensing analysis and spatial modeling to create new 
information. In addition, with ERDAS IMAGINE, you can visualize your results in 2D, 3D, movies and on 
cartographic-quality map compositions. The core of the ERDAS IMAGINE product suite is engineered to scale 
with your geospatial data production needs. Optional modules (add-ons) providing specialized functionalities 
are also available to enhance productivity and capabilities. 

IMAGINE Essentials is the entry-level image processing product for map creation and simple feature 
collection tools. IMAGINE Essentials enables serial batch processing. 

IMAGINE Advantage enables advanced spectral processing, image registration, mosaicking and image 
analysis and change detection capabilities. IMAGINE Advantage allows you to process parallel batches for 
faster output. 

IMAGINE Professional includes a production toolset for spatial modeling, image classification, feature 
extraction and advanced spectral, hyperspectral and radar processing.  

IMAGINE Photogrammetry maximizes productivity with state-of-the-art photogrammetric satellite and aerial 
image processing algorithms. 

  

New platforms 

Geospatial Licensing 2023 

Geospatial Licensing 2023 is required to provide concurrent licenses to 2023 products, including ERDAS 
IMAGINE 2023 Update 1. Versions of Geospatial Licensing prior to 2023 cannot successfully license ERDAS 
IMAGINE 2023 Update 1. 

ERDAS IMAGINE installers no longer attempt to automatically install Geospatial Licensing tools as part of the 
installer. To use geospatial licensing tools — for example, to set up a floating/concurrent license server — you 
must download and install Geospatial Licensing 2023 separately. 

Version 16.8 license files are required to run this release. Customers who have current Maintenance contracts 
and valid v16.8 licenses already do not need additional licensing to use ERDAS IMAGINE 2023 Update 1. 

You can find the appropriate download in the licensing portal. 
 

Security vulnerabilities 

A section is provided on the Hexagon community site to track security vulnerabilities and their potential impact 
on Hexagon products, including ERDAS IMAGINE. Please refer to this link for further information: 

Technical alerts (hexagon.com) 

 

  

https://supportsi.hexagon.com/help/s/licensingportal
https://supportsi.hexagon.com/help/s/technical-alerts?language=en_US
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New technology for ERDAS IMAGINE 2023 
Update 1 

Spatial Modeler  

Update 1 extends the capabilities offered by Spatial Modeler including new and improved operators, tabular 

previews for tables and matrices and support for Python 3.12.0. 

 

Updated Spatial Modeler operators in ERDAS IMAGINE 2023 Update 1 

 

2D Preview  

 

2D Preview now supports IMAGINE.Geometry directly, such as the output from Compute Footprint: 
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Add Images To Block 

 

This operator adds images to a block. The images must be of the same sensor model types as 
those for which the block was created. As part of this process, interior orientation of the images 
is solved. The status of the exterior orientation of the images is also set according to the value 
specified in the parameter dictionary. 

In previous versions this operator would fail if one (or more) of the input images was 
inappropriate for adding to the block. In this release this behavior has been changed so that if 
an inappropriate image is encountered a warning is issued, the image is skipped, and the 
process continues. This prevents the overall Spatial Model from failing unexpectedly.  

Assess Object Detection Accuracy  

 

The Assess Object Detection Accuracy operator has been modified to take a list of features (since the Detect 
Objects Using Deep Learning operator now can generate a list of features and Assess Object Detection 
Accuracy needs to work through the list). 

Create Image Pyramid 

 

The Create Image Pyramid operator has been enhanced to provide a Thematic Majority Resampling option as 
an alternative to Nearest Neighbor (or Max Pixel Decimation) when creating pyramids for thematic raster data. 
This same option is available wherever pyramids can be created, such as the View/Edit Image Metadata 
dialog.  
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In specific cases the Thematic Majority Resampling option can result in smoother looking data when zoomed 
out. Below is a screenshot showing two copies of the same landcover image (13473 x 12129 pixels) displayed 
fit to frame with Nearest Neighbor resampled pyramids on the left and the new Thematic Majority Resampling 
on the right: 

  

Detect Objects Using Deep Learning 

 

Detect Objects Using Deep Learning will now accept a list of rasters for input. 

For example, the Spatial Model below reads the file names of all NITF images in a source directory, passes 
the list of file names to an Iterator which reads each one to a list of rasters and feeds that list of rasters to the 
Detect Objects Using Deep Learning operator in order to identify trained objects in each input image.  
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Dictionary Input 

 

The Dictionary Input operator now reads JSON input files, which are sometimes supplied with satellite imagery 
to list metadata that can be useful in processing the data. 

Get JPEG 2000 Options 
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The Get JPEG 2000 Options operator now supports a wider range of pre-supplied options on the 
CompressionRatio port, as well as the ability to type arbitrary ratios via the Properties panel. This makes it 
possible to apply visually lossless compression ratios. 

 

Features Input 

 

Features Input will now extract features embedded in NITF files, such as the image footprint, cloud locations, 
etc. 

ICA 

 

The Independent Component Analysis (ICA) operator has been overhauled to work with larger (multigigabyte) 
input images. 
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Initialize Deep Intellect 

 

Initialize Deep Intellect now has a user-definable accuracy threshold at which to cease iterations. 

Initialize Image Segmenter 

 

Initialize Image Segmenter now has a user-definable accuracy threshold at which to cease iterations. 

Initialize Inception 

 

Initialize Inception now has a user-definable accuracy threshold at which to cease iterations. 
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Initialize Object Detection 

 

Initialize Object Detection now has a user-definable accuracy threshold at which to cease iterations. 

Initialize Random Forest 

 

Initialize Random Forest has been extended to specify the number of trees and set the class weights, enabling 
tuning of model robustness. 
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Point Cloud Build Selection Criteria 

 

In order to simplify the process of setting MinimumZ/MaximumZ ranges specific to each SpatialConstraint 
geometry, the Point Cloud Build Selection Criteria operator has been enhanced. 

You may now define an elevation constraint for each feature on port SpatialConstraint by providing an 
IMAGINE.List of IMAGINE.Double on port MaximumZ and/or MinimumZ, where the number of values in the 
list is the same as the number of features. If there are more values than features, the excess values are 
ignored. If there are fewer values than features, only the spatial constraint is applied. Alternatively, you may 
provide an attribute field name for MaximumZ and/or MinimumZ, in which case the attribute values are 
combined with each corresponding feature geometry to define the 3D spatial constraint. 

Replace NoData With 

 

Replace NoData With no longer attempts to fill beyond the image’s extent with the replacement value(s), i.e., 
outside the image remains NoData. This provides for more consistent processing when multiple datasets are 
being processed that have differing geospatial extents. 
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RPC Generator 

 

The RPC Generator operator now accepts a block as input on the ReferenceSource port. 

Previously, when using the RPC Generator operator to create an RPC file to go alongside an image file the 
image file had to already be associated with a 3D geometric model. This made it difficult to build a suitable 
Spatial Model if the model itself was going to build the 3D geometric model (i.e., if it did not already exist). Now 
that information can be stored in a block as part of the Spatial Model and that block is referenced for the 3D 
geometric model information. 

Segment Image Using Deep Learning 

 

Segment Image Using Deep Learning will now accept a list of rasters for input. 
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New Spatial Modeler operators in ERDAS IMAGINE 2023 Update 1 

 

Compute Summary Matrix 

 

Compute Summary Matrix returns a matrix containing a cross tabulation of the two input rasters. In the 
returned matrix, row-column position [i, j] contains the number of pixels that have value i in ZoneRaster and 
value j in ClassRaster. The values in ZoneRaster are referred to as zones and the values in ClassRaster as 
classes. 

The Matrix output by this operator is intended as input to the Zonal Summary <Statistic> operators in order to 
compute the <Statistic> of the classes of ClassRaster in the zones of ZoneRaster. 

Create Dataset Proxy 

 

Use Create Dataset Proxy to create an Unrestricted Access Image (UAI) file for a raster dataset in a specified 
directory, optionally with a specified name. The primary use of a UAI file is to provide writeable access to a 
raster dataset that is stored in a read-only location or is not itself writeable for some other reason. If the File 
Formats → Image Files (General) → Access Read-only Image Datasets through Writable Proxy Datasets 
preference is turned on, UAI files are created automatically in a default location when attempting to perform an 
edit operation on a read-only dataset. Use this operator if you want control over when or where a UAI file is 
created and used. 

Create Grid Features 

 

This operator generates a grid of rectangular feature tiles over the extent of the input raster stream. 
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The output features stream will contain ceil(raster width/TileWidth) x ceil(raster height/ TileHeight) area 
geometries. The geometries will butt join. The features on the right and bottom edges of the grid may extend 
beyond the extent of the input raster. 

Below is an example of using the Create Grid Features operator to create the tiling structure required for 
classifying an image using deep learning.  

 

Determine Accommodating Type 

 

Determine the minimum NumberType that will accommodate all possible values of all NumberTypes in the list. 

For example, if Type1 contains "u4" and Type2 contains "u8," "u8" is set as the AccommodatingType 
because all possible unsigned 4-bit values and all possible unsigned 8-bit values can be represented in an 
unsigned 8-bit value. However, if Type1 contains "u8" and Type2 contains "s8," "s16" is set as the 
AccommodatingType, because all possible unsigned 8-bit values and all possible signed 8-bit values cannot 
be represented by either an unsigned 8-bit value or a signed 8-bit value; it requires a signed 16-bit value to be 
able to represent the full range of both signed and unsigned 8-bit values. 
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Fill DEM Holes 

 

The operator identifies NoData pixels or areas, otherwise known as holes, in the input raster. It uses TIN 
interpolation between pixels that border the NoData areas, to determine the DN values used to update NoData 
pixels. Only NoData pixels within the convex hull of the TIN are modified. All other pixel DN values are passed 
through unchanged. 

Raster Statistics Per Raster Zone 

 

This operator computes selected statistical measures of all pixel DN values from ValueRaster that are 
overlaid by each zone (i.e., DN value) of ZoneRaster. Row i of the returned Table contains the statistical 
measure from ValueRaster of all pixels that have value i in ZoneRaster. By default, all supported statistics 
are computed and output. 

If required, the output Tables can be attached to the ZoneRaster raster stream as attribute fields by using the 
Create Column(s) and Attach Attributes operators. 

This operator provides a more efficient alternative to using multiple Zonal <Statistic> operators when multiple 
statistical measures are required. 
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Raster Summary Per Feature 

 

This operator computes the count of each DN value of the pixels of the input raster that are contained within a 
feature geometry (using the Primary Geometry field). The computed counts are added as attributes to the 
feature stream, one per value discovered in the input raster. The attributes are named by combining the value 
held by port AttributeNamePrefix and "<N>" where N is the pixel value. For example, by default, the name of 
the first column is "RS_Cnt1." 

Tabular Preview 

 

View AttributeTable, Table, Matrix or Scalar data on the fly in a tabular view. If multiple Tables or multiple 
Scalars are attached to the Tabular Preview operator, each Table or Scalar is represented as a column in the 
Tabular Preview pane. If an AttributeTable is being previewed, the Tabular Preview pane shows all columns 
for a single layer. You can choose which layer to preview on the Tabular Preview ribbon. Only a single 
AttributeTable or single Matrix can be previewed with each Tabular Preview operator. AttributeTables, Tables, 
Matrices and Scalars cannot be combined. If any Table or Table in an AttributeTable has a Bin Function, all 
Tables must have the same Bin Function. 
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The example below shows how this operator could be used to display a tabular view of three Tables output 
from Raster Statistics Per Raster Zone: 
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Spatial Model Editor improvements in ERDAS IMAGINE 2023 Update 1 

Execution Order 

A new panel has been added to the Spatial Model Editor called Execution Order. 

Spatial Modeler uses a pull model type of observer pattern where the end of the model chain requests data 
from its parent(s) and waits until the requested data is provided. This allows the chain to process only the data 
necessary to satisfy the request, so a subset of the input data may be used. Because of this, all execution of a 
model starts at the tail end of the chain. Any operator that does not have one or more of its output ports 
connected to another operator is a tail. A model may have multiple tails. In some cases, it is useful to 
recognize tail operators and know in which order multiple chains in a model will be executed. 

The Execution Order panel shows the order in which execution of operators in the current model will be 
initiated and allows you to change the order. 

When the Execution Order panel is active, each tail operator in the current model will have a number shown in 
the upper-right corner. This number indicates the order in which the operator will be executed. 
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Format support in ERDAS IMAGINE 2023 Update 1 

DS-EO support 

DS-EO imagery can be orthorectified using RPCs for quick and accurate georeferencing. 

RPF (CADRG and CIB) 

RPF products containing multiple images default to opening as a mosaic for easier access. 

On Demand Data (ODX)  

ODX was originally introduced in ERDAS IMAGINE 2023 as a space-saving concept based on the capability 
of a Spatial Model to provide on-the-fly processing and preview of raster data. These “virtual datasets” helped 
minimize overuse of valuable disk space. However, the concept was originally limited to raster data. ERDAS 
IMAGINE 2023 Update 1 has expanded support to features and point clouds. 

 

General ERDAS IMAGINE 2023 Update 1 

The following section highlights some other new capabilities added to ERDAS IMAGINE. 

Normalized Difference Red Edge (NDRE) index 

NDRE has become a common vegetation health index, especially in precision agriculture, replacing the use of 
NDVI. So, while it could already be easily applied via the Indices dialog, it has been added as a standard 
named option.  

The normalized difference red edge index (NDRE) is a vegetation index used in remote sensing for measuring 
the chlorophyll content in plants, which can be an indicator of crop health, biomass, etc. It is similar to the 
NDVI but uses the ratio of Near-Infrared and Red Edge wavelengths as follows: 

 

NDRE=(NIR−RE)/(NIR+RE) 

 

The Red Edge is the part of the electromagnetic spectrum centered around 715 nm. 

The Red Edge light of the electromagnetic spectrum isn’t as strongly absorbed by chlorophyll pigments as 
Visual Red light in vegetation, so the light can penetrate deeper into the canopy. Therefore, NDRE not only 
estimates the chlorophyll content of the outermost layer of a vegetation canopy, but also for that at lower 
levels, making it ideal for detecting the health of later-stage crop growth or of dense forest ecosystems. 

Added support for EPSG 5682, 5683, 5684 and 5685 (DB_REF) 

Several EPSG codes used by engineering survey and topographic mapping for railway applications in 
Germany (DB_REF) have been added. 

Saudi Arabian National PCS references (SANSRS) 

Support has been added for the new Saudi Arabian National PCS references (SANSRS). 
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New Colombian Cartographic system 

Support for EPSG code 9377 (CTM12): new Colombian Cartographic system has been added. 

All File-based Vector formats 

The file chooser now has an option in the File Type menu for “All File-based Vector formats,” which can also 
be set as the default filter when opening vector data. This makes it quicker and easier to search for you vector 
data. 

 

Direct-read NITF embedded shapefiles (CSSHPA and B) as vector layers  

Previously, the CSSHPA & CSSHPB DES shapefiles embedded in some NITF files had to be extracted as 
physical files before they could be displayed or used. Now they can be read directly from the NITF file without 
conversion. 

Save As… to LAZ format 

Previously point cloud data could only be saved to LAS format. Now it can also be saved to LAZ. 
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System requirements for ERDAS IMAGINE 
2023 Update 1 

ERDAS IMAGINE  

Computer/processor 
64-bit: Intel 64 (EM64T), AMD 64 or equivalent (four or more logical processors are strongly 
recommended) 

Memory (RAM) 16 GB minimum, more is strongly recommended 

Disk space 

• 11 GB for software 

• 7 GB for optional example data 

• Data storage requirements vary by mapping project1  

• SSD drives strongly recommended for both software and data 

Operating systems2, 3, 4 

• Windows 10 Pro (64-bit, version 1607 or higher) 

• Windows 10 Enterprise (64-bit, version 1607 or higher) 

• Windows Server 2019 (64-bit) 

• Windows Server 2022 (64-bit) 

• Windows 11 Enterprise (64-bit) 

• Windows 11 Professional (64-bit) 

Software 

• OpenGL 4.2 or higher is required for Globe Views (this typically comes with supported graphics 
cards5) 

• Java Runtime 1.7.0.80 or higher — IMAGINE Objective requires JRE and can utilize any 
installed and configured JRE of version 1.7.0.80 or higher; Microsoft Visual C++ 2010 x64. 
Redistributable is also required. 

• Python 3.8.x through 3.12.x can optionally be used for writing Python scripts that reference 
ERDAS IMAGINE libraries or access operators that are available in the Spatial Modeler 

• Python 3.8.x through 3.12.x are optionally supported for executing Python scripts in the Spatial 
Model Editor 

• Microsoft DirectX 9c or higher 

• .NET Framework 4.7.2 or higher 

• OpenCL 1.2 with a device that supports double precision (cl_khr_fp64) if wanting to GPU 
accelerate NNDiffuse and other operators (functions should fall back to the CPU if a suitable 
GPU is not present) 

• An NVIDIA card with CUDA Compute level of 3.5 or greater is recommended for use with Deep 
Learning and 5.0 or greater for other Spatial Modeler operators (most functions should fall back 
to the CPU if a suitable GPU is not present) 

Recommended graphics 
cards for stereo display6 

• NVIDIA Quadro P6000, P5000, P4000 and P2000 

• NVIDIA Quadro M6000, M5000, M4000 and M2000 

• NVIDIA Quadro K5200, K5000, K4200, K4000, K2200, K600 and K420  

• NVIDIA Quadro RTX 4000 

• NVIDIA Quadro RTX A4500 and RTX A5000 

Recommended stereo 
display monitors 

• 120 Hz (or above) LCD Monitors with NVIDIA 3D Vision Kit 

• 3D PluraView system from Schneider Digital7 

• Vision Engineering CONTOUR 3D stereoscopic GIS display 

Recommended stereo 
glasses and emitter kits 

• NVIDIA 3D Vision Kit 

• 3DTV Universal Emitter  

Peripherals All software installations: 

https://www.3d-pluraview.com/en/
https://www.visioneng.us/contour/
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• One Windows-compatible mouse with scroll wheel or equivalent input device  

• Printing requires Windows-supported hardcopy devices8  

Software security (Hexagon Geospatial Licensing 2023) requires one of the following: 

• Ethernet card  

• One USB port for hardware key 

Advanced data collection requires one of the following hand controllers:9 

• TopoMouse or TopoMouse USB 

• Immersion 3D Mouse 

• MOUSE-TRAK  

• Stealth 3D (Immersion), S3D-E type, Serial Port 

• Stealth Z, S2-Z model, USB version 

• Stealth V, S3-V type (add as a serial device) 

• 3Dconnexion SpaceMouse Pro10 

• 3Dconnexion SpaceExplorer mouse10 

• Z/I Mouse 

Software interoperability 

• ERDAS IMAGINE can be safely installed on a computer that has GeoMedia 2022 or GeoMedia 
2023 installed; however, for greatest compatibility, it is highly recommended to install matching 
versions (including updates) 

• ERDAS IMAGINE 2023 requires GeoMedia 2023 for live linking (order of installation does not 
matter) 

• ERDAS IMAGINE 2023 can read web services from an ERDAS APOLLO 2022 catalog, but not 
from ERDAS APOLLO 2023. Support for ERDAS APOLLO 2023 should be released in a later 
update. 

• ERDAS IMAGINE can interact with File Geodatabases (but ArcGIS installation is not required for 
File Geodatabase access) 

Database engines 

• PostgreSQL 13.2 with PostGIS 3.1.1: PostGIS can be used to store GeoMedia Features (.pfp) 

• Oracle Server 19c (12.2.0.3) 64-bit: Oracle Server 19c can be used to store Oracle Spatial 
Features (.ogv) (requires Oracle Spatial), as well as GeoMedia Features (.ofp) 

• Microsoft SQL Server 2019 64-bit: Microsoft SQL Server 2019 can be used to store GeoMedia 
Features (.sfp) 

Internet connection 
• ERDAS IMAGINE LiveLink for Google Earth Engine requires an active internet connection to 

operate. It has no offline mode. 

ERDAS IMAGINE system requirements notes 
1 Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity. 
Reading data from one disk, writing temporary data to a second disk and writing data to a third disk improves 
performance. Disk arrays improve productivity, but some RAID options slow performance. Network disk drives 
are subject to network limitations.  

2 Server operating systems are not supported for IMAGINE Photogrammetry, ORIMA or ERDAS ER Mapper. 

3 The 3D stereo viewing and peripheral requirements of IMAGINE Photogrammetry limit its operating system 
options.  

4 Includes ERDAS ER Mapper support. 

5 Windows provides a generic OpenGL driver for all supported graphics cards; however, an OpenGL-
optimized graphics card and driver are recommended for these applications.  
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6 Graphics cards certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be 
compatible but are not certified in the current version. Drivers must not be newer than R418. NVIDIA dropped 
3D Vision support for drivers released after R418 U4 (425.31), which was released on April 11, 2019. 

7 Stereo monitors certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be 
compatible but are not certified in the current version. 

8 HP-RTL drivers are recommended. Windows 64-bit print servers require 64-bit print drivers.  

9 Stealth S-Mouse (S2-S model) and MOUSE-TRAK are the only supported hand controllers in Stereo Analyst 
for ERDAS IMAGINE.  

10 3Dconnexion mice are supported in IMAGINE Photogrammetry.  
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Issues resolved: ERDAS IMAGINE 2023 
Update 1  

IMAGINE Essentials 

Support ticket  Summary 

00187940 Displaying Pleiades Neo data via Image Chain causes “bad allocation” and endless Spatial Modeler errors 
if Preferences are set to request a band for display that is not present in the image. 

00210282 Send to Word outputs corrupt image from thematic Image Chain data which has large extents of NoData 

00171523 NetCDF file does not open with coordinate information 

00188965 Reprojection from EPSG: 32630 to EPSG: 27700 is not correct 

 

IMAGINE Advantage 

Support ticket Summary  

00208579 Recode Operation giving different results in Versions of 2018, 2022 and 2023 

00197675 Export ADRG dialog closes unexpectedly when changing Chart Series or Country Code values 

00146814 Ribbon ICA (Independent Component Analysis) model fails with larger (> 90GB) input image 

00022744 MosaicPro Active Area option is incorrectly calculating image area 

00217270 Color table of input thematic data not applied to MosaicPro output 

00138780 Wide strip of data missing from recent Capella SLC image after orthorectification 

00194171 Subset of LAZ format point cloud results in incorrect output 

00175664 Convolution tool does not recognize NoData pixels 

00188661 Perform Affine Resample outputs empty raster 

00215404 
00186503 
00185573 

ERDAS IMAGINE 2023 (version 16.8) is presenting a resample problem when using Control Points tool 

 

IMAGINE Expansion Pack 

Support ticket Summary  

00192642 AutoSync interface becomes unusable (missing icons) after APM 
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IMAGINE Photogrammetry 

Support ticket Summary  

00190625 Adding TIFF to block file crashes IMAGINE if auto-associate preference for elevation library is on 

00195107 PRO600 Snapping issue while collecting lines in stream mode 

00217191 Invalid Units error: Photogrammetry 

IMAGINE Professional 

Support ticket Summary  

00113276 Accuracy Assessment does not enforce minimum number of points when all classes are not selected 

00023289 Classifyisodata fails when output file name or path has parenthesis 

00023307 New/Open Zonal Change project resets the custom layout to default 

IMAGINE Objective 

Support ticket Summary  

00023237 Zonal Mean calculation discrepancy exists between Objective VOP Zonal:Mean cue and IMAGINE 
Thematic Zonal Attributes 

Spatial Modeler  

Support ticket Summary  

00181926 Classify Using Machine Learning model fails in ERDAS IMAGINE 2023 

00023102 Initialize Random Forest fails with big data (266863 features) 

00187852 Spatial model preview fails with error "invalid vector<T> subscript" 

00190141 Importing 'OpenCV' and/or 'Numpy' in the Python Operator throws errors 

00187068 "Unsupported moniker" error reported from Spatial Modeler 2023 
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New technology in ERDAS IMAGINE 2023 
This section describes the enhancements provided by the original release of ERDAS IMAGINE 2023 

Spatial Modeler  

Preview operators 

The Preview operator has been renamed 2D Preview and three additional types of Preview operators have 
been added: 3D, Chart and Web. 

Previews are tools provided by the Spatial Modeler Editor that are generally used for visualizing intermediate 
and terminal outputs of a Spatial Model during development to quickly determine if the processing appears to 
be producing the expected result. Rather than having to wait for the data to be processed in its entirety and 
outputs written to a disk, Previews can pull just the data required through the model to display the selected 
extent and scale. For example, if previewing raster via 2D Preview results in a 2D View with a Fit to Window 
extent, only the appropriate pyramid level of the input data will be used for processing. Conversely, if the data 
is displayed at 1:1 raster pixels to screen pixels, only the pixels that fall within the extent of the 2D View will be 
processed and displayed. In this manner, the amount of data processed is minimized so results can be viewed 
more quickly and analyzed for the impacts of changing upstream parameters. Note that this relies on there 
being no upstream operators that are global in nature (i.e., that require the entire extent of the data to be 
processed at full resolution to produce results, such as the Clump or Intersect Features operators.) If there are 
global operators present, the benefits of processing only the displayed scale and extent will be diminished, 
and previewing may be slower if your incremental changes to the model are upstream of any global operators. 

2D Preview 

 

When you click on the Preview button on the Home tab, the data connected to a 2D Preview operator is 
displayed in a 2D View. If there is an empty 2D View, the layer will be created in that 2D View; if there is no 
empty 2D View, a new 2D View is created. A separate layer will be created for each item on each Input port on 
the 2D Preview operator, and a separate 2D View is used for each 2D Preview operator in the model. Any port 
that does not contain data will be ignored; however, if no input ports contain data, the operator will give a 
warning and no preview will be created. 

If the data connected to the Input port is raster, an Image Chain layer is created and one of the Image Chain 
context tabs will be available for the layer, depending on the type of the raster. If the data connected to the 
Input port are Features or PointCloud, the layer in the 2D View will have a Preview context tab. 

PointCloud data can also be previewed in 3D by adding a 3D Preview operator to your model. 

2D Preview now accepts List of IMAGINE.Features and List of IMAGINE.PointCloud (along with the already 
supported List of IMAGINE.Raster) to facilitate previews of outputs from Iterators and others. 
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3D Preview 

. 3D Previews are designed to enable efficient review of point cloud information flowing through a spatial 
model. For example, you may wish to visualize the results of removing noise from  point cloud data in the 
Globe View. This will give you the opportunity to assess if the noise points have been removed from the data 
and, if necessary, to tweak the parameters. 

When you click on the Preview button on the Home tab, the data connected to the 3D Preview operator is 
displayed in a Globe View. A separate layer will be created for each item on each Input port on the 3D Preview 
operator, and a separate Globe View is used for each 3D Preview operator in the model. Any port that does 
not contain data will be ignored; however, if no input ports contain data, the operator will give a warning and 
no preview will be created. 

 

Limitations: 

Globe Views require a graphics card that supports OpenGL 4.2 or higher. If the requirements are not met, the 
Globe View will fail to open with a message advising you of the nature of the shortcoming(s). 
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Chart Preview 

 

View Table data on the fly in a Chart. 

Previews are tools provided by the Spatial Modeler Editor that are generally used for visualizing intermediate 
and terminal outputs of a Spatial Model during development to quickly determine if the processing appears to 
be producing the expected result. Chart Previews are designed to provide an efficient method for reviewing 
tabular information in a spatial model. For example, you might wish to visualize if the distribution of classes in 
landcover data appears to be correct by sending the histogram information to a Table, inputting that to a Chart 
Preview and generating a pie or bar chart of the relative areas covered by each class. Altering an upstream 
parameter in the Spatial Model might then cause a change in the visible distribution of classes in the pie chart. 

 

When you click on the Preview button on the Home tab, the data connected to the Chart Preview operator is 
displayed in a Chart Preview pane. The data from all Input ports on the Chart Preview operator will be 
displayed in a single Chart Preview pane, and a separate Chart Preview pane will be created for each Chart 
Preview operator in the model. Any port that does not contain data will be ignored; however, if no input ports 
contain data, the operator will give a warning and no preview will be created. 

The values to be graphed are usually the numeric values present in one or more input Tables. String type 
tables can also be input, but their use is primarily limited to labeling the corresponding numeric values from a 
second Table. Color type tables can be used for the color palette of line, scatter or bar charts or for the colors 
in pie charts. 
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The screenshot below shows a Spatial Model that analyzes polygonal geometries to be used as training areas 
for supervised classification. The pixels falling within the extent of each class polygon are mapped as band-to-
band scatterplots in the Chart Tools to visually explore the separability of the training data.  

 

 
Web Preview 

 

The Web Preview operator enables you to view a file in an embedded browser pane. When you click on the 
Preview button on the Home tab, the files specified by the connections to the Web Preview operator are 
opened in an embedded browser pane. A separate browser pane will be created for the file(s) on each Input 
port of each Web Preview operator in the model. Any port that does not contain data will be ignored; however, 
if no input ports contain data, the operator will give a warning and no preview will be created.  

Any file type that is supported by a web browser – such as GIF, MP4 and PDF – can be viewed. 
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Auto-generate an operator user interface (UI) for those that lack dedicated ones 

In a prior release, a function was added to change the cursor if it passed over an Operator that could start a 
dedicated dialog if double-clicked. Confusion among users remained as to when an operator could be double-
clicked. 

Consequently, the 2023 release extends the capability so that all operators can be double-clicked to start a 
configuration dialog. If they do not have a dedicated dialog for editing properties, then one will be auto-
generated in a similar fashion to the auto-generated dialogs when a Spatial Model is Run or Previewed. 

  

"Create Iterator" and "Create Catch Error" options added to Ribbon tab 

When prototyping a Spatial Model, especially when creating sections that require use of an Iterator or other 
sub-model, it’s often easiest to build and test that section of the model using just one of the inputs, such as 
simulating a single iteration. Once the model is working correctly with one item you can turn that section into 
an Iterator. With the 2023 release this is made easier with the addition of “Create Iterator” and “Create Catch 
Error” options that apply to the selected operators: 
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…helps create: 

 

Spatial Models as On-Demand Data (odx) 

On-Demand Data is a space-saving concept based on the capability of a Spatial Model to provide on-the-fly 
processing. Consider a situation where you have a 1GB Landsat multispectral image. From this image you 
might want to derive: an NDVI; a Leaf Area Index (LAI); a pan-sharpened true-color view; a Snow and Ice 
Index; an atmospherically corrected surface reflectance version; a land/water mask; a Tasseled Cap; the first 
three Principal Components; and a change detection when compared to a different date image. Creating all 
those products as output files would be easy using individual spatial models, but each results file would 
consume considerable additional disk space and time. 

Instead, On-Demand Data (.odx) can be created for each product. These "virtual datasets" consume negligible 
space and time. Only the original input Landsat multispectral image file needs to be stored on disk. The other 
products are derived on the fly from the Spatial Model that defines the On-Demand Data. But the On-Demand 
Data can still be used like other input datasets in ERDAS IMAGINE (or other applications that use Spatial 
Modeler) to be viewed in a 2D View, fed into an Unsupervised Classification, exported to an exotic file format 
or fed into another Spatial Model. 
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Looking closer at one of the examples above, you might want to take the Landsat multispectral image and 
calculate an LAI to look at vegetation health in the area. However, LAI requires the input data to be 
Reflectance data (in the unitless 0-1 approximate range.) The Landsat file has been corrected to Surface 
Reflectance by the data provider (USGS), but it was also scaled and offset to unsigned 16-bit integer for ease 
of dissemination (along with a metadata file that provides information such as the multiplier and offset for each 
band to convert back to floating point surface reflectance values). It is therefore easy to build a small Spatial 
Model that takes in the Landsat image, reads the metadata file, extracts the multiplier and offset values and 
applies these to the DN values to produce true floating point surface reflectance values suitable for feeding to 
the LAI function. But you don’t want to create a floating-point version of the Landsat image on disk simply to 
feed it into the LAI function and produce a third dataset. So rather than (or in addition to) adding a Raster 
Output operator in the Spatial Model to convert to Surface Reflectance, a Preview operator is added at the 
point where the required data would be produced by the model. If a Preview operator is selected in the Spatial 
Model Editor, an option will be enabled to Create On-Demand Data. This will prompt you to provide a name of 
the On-Demand Data file (a small .odx file on disk that contains the Spatial Model and pointers to the input 
data). This On-Demand Data file can then be treated like any other geospatial dataset supported by the 
software. For example, the On Demand Data file defining how to convert DNs to Surface Reflectance could be 
fed as input to the LAI option in the Indices dialog. 

You may wish to avoid the use of On-Demand Data in some cases. Spatial Models that include global 
operations may not be suitable for efficient display in a 2D View, for example. Or if the data will be re-used 
multiple times, such as needing the Landsat Surface Reflectance values as input to several different 
processes. In these cases, it might be more efficient to produce an actual dataset on disk. 

Create an On-Demand Data File 

If a Spatial Model contains one or more Preview operators an On-Demand Data file can only be created 
corresponding to one selected Preview operator. However you could create multiple Virtual Datasets, one for 
each Preview. 

A single Preview operator can also have multiple input ports. In this instance, the On-Demand Data derived 
from that Preview will be considered a multilayer dataset. The File Chooser will present the Sub-Images tab 
(or another appropriate tab) so that the desired layer can be selected. If displayed in a 2D View the On-
Demand Data will populate a Related Data panel. 

On-Demand Data is also not necessarily limited to raster data. 

Open an On-Demand Data File 

In a File Selector, click the File Type dropdown arrow to select On-Demand Data (*.odx). 
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Updated Spatial Modeler operators 

Compute Transform 

 

This operator takes control points and their measurements in an image and creates a transform from the 
image coordinate system to the control point coordinate system. 

ERDAS IMAGINE 2023 has been updated to support the creation of a wider range of 3D orthorectification 
transform types including: 

• Camera 

• Projective Transform 

• Direct Linear Transform (DLT) 

Create Column(s) 

 

A column is defined by a name and a Table of values. The Attribute Table set on the AttributeTableOut port 
can be added to a Raster or Features using other operators, such as to add color definitions or class names 
for thematic pixels.  

The operator has been updated to automatically adjust the number of rows in cases where the number of rows 
defined on AttributeTableIn and AttributeValuesn differs. 

  



ERDAS IMAGINE 2023 Update 1 

2 April 2024  39 

Create SGM Point Cloud  

 

This operator extracts a point cloud from a stereo image pair using Semi-Global Matching (SGM) and saves it 
to an output point cloud.  

It has been enhanced with a new GroundResolution port to account for high vs. low resolution input images. 

Accepted values are: 

• Auto 

• High 

• Low 

In High-resolution images, features such as buildings, utility poles, tree canopies, road markings and other 
infrastructure details are clearly visible. Images with a ground resolution of 50 cm or smaller are considered 
High-resolution images. 

The point cloud creation process attempts to extract the elevations of these features as accurately as possible. 

If set to Auto (the default), the operator determines if the input images are High-resolution or not.  

This option is applicable only when SurfaceType is "Sharp." 

Data information 

 

This operator provides basic information about a data stream. Use of this operator in sub-models has been 
made easier via better error messaging. 
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Define Image Parameters For Camera Model 

 

This operator creates a set of image parameters that are used when adding a camera sensor model to an 
image.  

The CameraName port has been modified to optionally take an input dictionary in which the full set of 
parameters that describe the frame or digital camera that generated the data may be specified. If these image 
parameters are added to a block, the camera parameters will also be added if they do not already exist. 

Generate Deep Learning Training Chips 
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Generate Deep Learning Training Chips is now capable of generating image chips for use in Semantic 
Segmentation. 

Get ECW Options 

 

This operator creates the format-specific output-option dictionary for Enhanced Compressed Wavelet (ECW) 
format. This can then be fed to the Raster Output operator to control how an output ECW file might be 
generated. 

When compressing 16-bit imagery to ECW it is important to provide the minimum and maximum DN values of 
the input data to avoid over-compression of the output. For example, if the data effectively has an actual bits 
per pixel of 11 bits, but has to be stored as 16 bit, it is important to specify the range is 0-2047, not 0-65535. 
Consequently, a FindMinMax port has been added. 

If set to True and there are no statistics available on the input Raster, this port option causes the software to 
go through the pixels to find the minimum and maximum values. This improves compression and image 
quality, but will take more time. 

When Auto is selected, it is equivalent to a FindMinMax value of False for 8-bit output and FindMinMax value 
of True for 16-bit output. 
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Get TIFF Options 

 

The Get TIFF Options operator creates the format-specific output-option dictionary for Tagged Image File 
Format (TIFF) Support. 

An option has been added for reading and writing using Adobe Deflate compression. 

Machine Intellect Information 

 

This operator provides basic information about a machine intellect and has been extended to provide 
information about imported deep learning models (see the Import operators detailed below.) 

Raster Match 
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This operator is used to change the distribution of pixel values in a Raster (OriginalRaster) to be like a given 
distribution (DesiredDistribution.) DesiredDistribution can either be another Raster or a Table (such as an 
ideal histogram distribution.)  

The operator has been corrected to now work with 16-bit imagery. 

Resize Table 

 

This operator has been enhanced to copy the (appropriately adjusted) bin function when resizing a Table. 

The CopyBinFunction port specifies whether to copy the bin function (if present) from TableIn to TableOut. 

If CopyBinFunction is true and TableIn has a Direct or Linear bin function, the bin function on TableIn will be 
extended or truncated (depending on whether rows are added or removed) and set on TableOut. 
If CopyBinFunction is false or TableIn has no bin function, TableOut will have no bin function. 
If CopyBinFunction is true and the bin function on TableIn is not Direct or Linear, the operator will fail. 
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New Spatial Modeler operators 

Attach Metadata 

 

This operator attaches metadata to GeospatialDataIn. Any existing metadata is replaced. If no metadata is 
supplied, GeospatialDataOut will have no attached metadata. 

Only the metadata is affected by this operator. Properties that might be removed by other streaming operators 
due to alteration of the streamed data, such as the Attributes or Vertical CRS of a Raster, are fully retained. 

Below is an example of using the Attach Metadata operator to reattach the metadata from the input raster to 
the output raster, for example when performing a Raster Expurgation operation. 

 

Classify Point Cloud Using Deep Learning 

 

This operator uses deep learning to classify points from the input point cloud. 

Only those points whose current class value matches one of the value(s) specified in the SourceClasses port 
will be considered for classification. By default, class values 0 (Never Classified) and 1 (Unclassified) are 
considered as source classes. 

The points from SourceClasses can be filtered further by providing additional criteria using the 
SelectionCriteria port. All points input via PointCloudIn will be output to PointCloudOut even if they were 
not considered for classification. 
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Compute Georeferencing From Image Parameters 

 

This operator creates Georeferencing (of type IMAGINE.CoordinateOperation) from an image parameter 
dictionary that is based on a sensor model. 

The Georeferencing can then be passed to the Associate Georeference operator, for example, to orient the 
image with the model. The georeferenced image can be used for downstream processes such as point 
matching with a reference image using Generate Control Points Based On Reference. 

Compute Georeferencing Using Edge Matching 

 

This operator accurately aligns the overlap area between adjacent georeferenced rasters to each other using 
edge matching. This will generate refined georeferencing for all rasters because the required shifts will be 
divided between the rasters. Edge matching may also be a good choice when the overlap area is small and it 
is undesirable to apply the same transform that is suitable for the overlap region to the entire raster. 

Compute Interior Orientation For Frame Camera  

 

This operator produces coefficients that can be used to construct an affine transformation that converts from 
millimeters in film space (Fx, Fy) to pixels in pixel space (Px, Py) of the sensor. 
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Define Adjustment Options For Projective Transform 

 

This operator defines adjustment options for a 2D/3D projective transform model for use with the Compute 
Transform operator (see above). If the input points to Compute Transform are 2D, a 2D transform will be 
created. If the points are 3D, the transform will be 3D. 

The Projective Transform model is based on a Rational Polynomial Functions and provides a powerful 
modeling capability for multiperspective satellite images such as Landsat, SPOT and QuickBird. While the 
best way to transform and orthorectify is to use sensor-specific models, the projective transform can be used 
in situations where no sensor model and ephemeris information are available. 

Define Point Geometry 

 

This operator creates a Point geometry from a set of input values representing the coordinate. 

The coordinate reference system given to the operator will determine the coordinate inputs that must be set 
(3D requires X Y and Z; 2D requires X and Y; 1D requires Z). If no coordinate reference system is given, an 
unknown CRS will be used whose dimensionality will be determined by which coordinate inputs are set. 

Generate SIFT Match Points 

 

This operator uses a variant of the Scale Invariant Feature Transform (SIFT) algorithm to automatically identify 
common points (scale and orientation invariant features) that occur in both an input image (which is usually 
unreferenced) and a reference image. Using these point matches, a transformation is generated that maps the 
coordinate space of the input image to that of the reference. This technique is commonly used as part of a 
process to georeference unreferenced imagery based on a geospatially accurate reference image base or to 
simply co-register two images. It is also commonly used as an initial step in a more complex photogrammetric 
matching approach. 

In addition to generating an affine transformation that can be easily applied to the input image, the 
automatically generated feature points can also be output to a ControlPoints dictionary so that they can be 
used in more complex geometric models if desired. 
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Below is an example of a Spatial Model that uses Generate SIFT Match Points to create an initial location for 
the unreferenced input image and then further refines the geometry model by using Generate Control Points 
Based On Reference and then Compute Transform with the new Projective Transform option to then ortho 
correct the image. 

 

Geospatial Data Output  

 

This operator saves geospatial data to a new file-based container. The formats supported by Geospatial Data 
Output allow for multiple Rasters and/or Features to be part of the same dataset (referred to as a container). 
Single Rasters may be saved to a larger selection of formats (including non-container formats) via the Raster 
Output operator. Likewise, single Features may be saved to a larger selection of formats (including non-
container formats) via the Features Output operator. 

Container formats currently include GeoPackage. 

Names for the individual layers in the output container file can be set using the Set Data Name operator. 

Get IMAGINE Image Options 

 

This operator creates the format-specific output-options dictionary for IMAGINE Images. 

The primary reason for introducing this operator is to provide control over the new LargeImageStrategy for 
.img files. This provides a new way of storing data Internal to a .img file that includes the ability to losslessly 
compress data even if it is over 2GB (rather than using an uncompressed .ige external file), as well as being 
able to store NoData location information as a mask (rather than using a value). However, these new 
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capabilities may not be supported by other software applications, so the option to store using the older 
External formatting is also provided.  

These options work as described below: 

 

LargeImageStrategy NoData Handling Comments 

External A mask will not be 
persisted; NoDataValue 
handling is unaffected. 

When the uncompressed raster size is greater than 
2GB, a binary-formatted .ige file is produced. 

Internal A mask will be 
persisted; NoDataValue 
handling is unaffected. 

When the uncompressed raster size is greater than 
2GB, .img files with 64-bit offsets that are not compatible 
with versions of ERDAS IMAGINE prior to 2023 (version 
16.8) and possibly other packages are produced. 

 

Import Deep Learning Classifier 

 

This operator imports TensorFlow deep learning classifiers created with other software. 

A classification model is a deep learning model that accepts a batch of rasters and produces a batch of 
probabilities that each image is of a given class. The model operates on rasters of size ProcessingWidth x 
ProcessingHeight. 

Classification models should accept one array of shape (BatchSize, ProcessingWidth, ProcessingHeight, 
BandCount) as input, representing the input raster to classify. They should produce an array of shape 
(BatchSize, ClassCount) floating point numbers as output, representing the probability that the input is of that 
class. 

The model should be a TensorFlow 2 model, saved using tensorflow.keras.model.save or downloaded from 
TensorFlow Hub. 

Import Object Detector 

 

This operator imports TensorFlow deep learning object detector created with other software. 
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An object detector is a deep learning model that accepts a batch of rasters and produces a batch of detected 
objects. 

Object detectors should accept one array of shape (BatchSize, ProcessingWidth, ProcessingHeight and 3) as 
input representing the input raster in which to detect objects. ProcessingWidth and ProcessingHeight are 
defined by the Detect Objects Using Deep Learning operator. 

Import Semantic Segmenter 

 

This operator imports TensorFlow deep learning segmentation models created with other software. 

A segmentation model is a deep learning model that accepts a batch of raster tiles and produces a batch of 
rasters where each pixel represents the probability that the input pixel is of a given class. The model operates 
on rasters of size ProcessingWidth x ProcessingHeight. 

Segmentation models should accept one array of shape (BatchSize, ProcessingWidth, ProcessingHeight and 
BandCount) as input representing the input raster tile to segment and produce an array of shape (BatchSize, 
ProcessingWidth, ProcessingHeight and ClassCount) floating point numbers as output representing the 
probability that each input pixel is of that class. 

Read Digital Camera Parameters From Australis File 

 

This operator reads digital camera parameters needed for setting up a Digital Camera from an Australis 
camera file. 

Read Frame Camera Parameters From Australis File 
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This operator reads frame camera parameters needed for setting up a Frame Camera from an Australis 
camera file. 

Refine Deep Learning Classifier 

 

This operator refines the training on an existing deep learning classifier by supplying more training samples. 
This can be used to improve the overall accuracy or to tailor training for a new environment. The classes and 
band count in the training data must match the input machine intellect. 

Refine Object Detector 

 

This operator refines an existing object detector by supplying more training samples. This can be used to 
improve the overall accuracy or to tailor the training for a new environment. The classes in the training data 
must match the input machine intellect. 

Refine Semantic Segmenter 

 

This operator refines the training on an existing Semantic Segmentation machine intellect by supplying more 
training samples. This can be used to improve the overall accuracy or to tailor the training for a new 
environment. The classes and band count in the training data must match the input machine intellect. 
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Replace String 

 

Replace String searches StringIn for occurrences of Search and replaces them with Replacement. You can 
search and replace the first, last or all occurrences of Search. The search is performed case-insensitive 
(based on the default locale), but the replacement is done with Replacement exactly as it is supplied to the 
operator. 

Below is an example of how this operator might be used in a model to convert an input IMG file to TIFF and 
create the output TIFF file in the same directory as the input IMG. 

 

Select Point Cloud Classifier 

 

Spatial Modeler provides a selection of trained machine intellects for point cloud classification for different 
types of datasets/domains, for example, Airborne LiDAR. The operator allows you to select one of these 
intellects for use with the Classify Point Cloud Using Deep Learning operator. 

Set Data Name 

 

This operator sets the name property of the data, if supported. This may be used by Output operators to set 
the identifier of the data. For example, in Geospatial Data Output (see above), the name will be used as the 
table name when creating a GeoPackage. Another use of this operator is to set the name that will be 
displayed for the Layer in the Table of Contents when Previewing a dataset. 
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Below is an example of a model that outputs both a Raster and Features to a single GeoPackage file using the 
Geospatial Data Output operator. The Set Data Name operator is used to set the name that will be used for 
the layer-specific table when creating the GeoPackage. 

 

Below is an example of a model that previews three Raster data streams. By using the Set Data Name 
operator to set the name on the stream before feeding it to 2D Preview, the Table of Contents for the 2D View 
then identifies each dataset with the given name, making it easy to tell which dataset is which. The title bar of 
the 2D View also shows the dataset name of the top layer. 
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Format support 

Select Layer To Add dialog displays improved icons for supported formats 

In prior releases the Select Layer To Add dialog would show some files, such as .jp2 files, with generic icons 
such as the “file” page icon, giving the false impression that the file might not be supported. This release has 
updated numerous file extensions to show more appropriate icons.  

 

IMAGINE Image File format (IMG) 

The IMAGINE Image File Format (IMG) has been extended to provide support for lossless compressed IMG 
files larger than 2GB (rather than using an uncompressed .ige external file), as well as the ability to persist a 
NoData mask within the IMG file (rather than using a value).  

However, these new capabilities may not be supported by other software applications yet, so the option to 
store using the older External formatting is provided via a Preference. See the IMAGINE Image Files (Native) 
preference category. 

The screenshot below shows the same large thematic image stored first as an External format IMG and 
second as a new Internal format IMG. Note that the External formatting results in a set of three files that in 
total are 2.5 times larger than the two files created using the new Internal formatting.  
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Hexagon Smart Point Cloud (HSPC) 

HSPC is a powerful, robust format for handling point cloud data. 

ERDAS IMAGINE now directly supports point clouds in the Hexagon Smart Point Cloud format (HSPC). 
Certain Hexagon scanners allow exporting point clouds in HSPC, a 3D-tiled format enabling customers to 
avoid additional conversion steps into formats such as LAS. Advantages compared to OGC 3D tiles are better 
compression of the tile payload and precise encoding of point locations. 

Meta Raster Format (MRF) and Limited Error Raster Compression (LERC) format read 

Meta Raster Format (MRF) is an image and data storage format designed for fast access to imagery within a 
georeferenced tile pyramid at discrete resolutions. It was originally developed at NASA's Jet Propulsion 
Laboratory. 

Limited Error Raster Compression (LERC) is a format for compressed raster image data and is often used to 
store compressed raster data in the MRF format. 

Support for reading both of these has been added. 

Sentinel-3 SLSTR Level-2 WST read 

The SLSTR Level-2 WST product respects the Group for High Resolution Sea Surface Temperature 
(GHRSST) L2P specification and includes a single SST field derived from the best performing single-
coefficient SST field in any given part of the swath, plus a number of supporting data fields providing context 
for the SST fields. 

Adobe Deflate in GeoTIFF 

Deflate is a lossless data compression technique that uses a combination of LZ77 and Huffman coding. 
Support has been added to both read TIFF files using this compression as well as to create TIFFs using 
Deflate.  

Better handling of container formats such as GeoPackage  

Container formats are a type of storage format that allows more than a single dataset to be stored. For 
example, GeoPackage format allows multiple vector and raster datasets to be stored in a single GeoPackage. 
Prior releases supported reading of data from these container formats.  

Spatial Modeler 2023 has been enhanced to enable the writing of multiple datasets into container formats 
such as GeoPackage (via the Geospatial Data Output operator). 

USGS Spectral Library Version 7 support 

USGS Spectral Library Version 7 has been added to the available spectral libraries associated with the 
hyperspectral processing tools in ERDAS IMAGINE 2023. 
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General ERDAS IMAGINE 

New Home tabs 

Functionality in the ERDAS IMAGINE 2023 ribbon interface has been reorganized such that the Home tab is 
now context sensitive to the type of active View or Pane. Consequently, there are five discrete Home tabs. 
These make the appropriate tools for interacting with the active View much more readily available to the user.  

In addition, all the Home tabs have an initial menu (in the Workspace group) that enables any other type of 
View to be started (or to start another one of the currently active type.) 

Every Workspace contains a Home tab, consisting of tool tab groups for Workspace management and 
information, as well as groups specific to the current View, such as editing, View extent, etc. The tools are 
context sensitive, meaning that whether tools are active or what they do may depend on the current layer or 
the currently selected item. 

2D View 

 

The 2D View displays raster, vector, point cloud and annotation data in a 2D View window. The Home tab for 
a 2D View is as shown above. 

Map View 

 

The Home tab for a Map View contains tools for creating a Map Composition in the Map View. 

A map composition or map file is a file created with several components of the ERDAS IMAGINE Workspace, 
usually to be output to hard copy. The map composition contains map frames and map annotation. Map 
composition files have the extension .map. They can be created, edited and viewed in the Map View. 

The Home (Map View) tab and the Drawing tab are the primary tabs for working in the Map View. Other 
frequently used tabs while creating map compositions are the respective raster tabs such as Multispectral and 
Panchromatic. 

3D View 

 

The Home tab for a 3D View contains tools for working in the 3D View that renders 3-dimensional DEMs, 
raster overlays and vector and/or annotation feature layers. The functions of VirtualGIS are rendered through 
the 3D View. The tools on the Home (3D View) tab are context sensitive, meaning that whether tools are 
active or what they do may depend on the current view, the current layer or the currently selected item. 
 

Globe View 
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The Home (Globe View) is a new Home tab with tools specific to the 3D Preview operator in Spatial Modeler. 
The Home tab for a Globe View contains tools for working in the Globe View that renders 3-dimensional point 
cloud layers. 

Model View 

 

The Home (Model View) tab provides all the tools necessary for interacting with the Spatial Model Editor. 

DHHN2016 vertical datum 

Support for the German DHHN2016 vertical datum transformation grid has been added. 

Option to save Image Chain styling parameters (with Global/Per User option) 

In prior releases, changes made to the styling of an image displayed using the Image Chain rendering engine 
(which is now the default behavior) were automatically saved so that if that image were re-opened (by the 
same user) the display would default to the last saved styling.  

In some instances, this caused confusion, especially if the styling last applied were wrong, such as a failed 
attempt to improve the contrast and brightness distribution of the image.  

Consequently, ERDAS IMAGINE 2023 introduces a new menu in the Settings group of the specific Image 
Chain’s tab to enable saving modes to be configured. The user can decide whether styling should be 
automatically saved or not (which then requires the user to intentionally select an option to save a specific 
styling) and if that styling should apply just for this user or for all users of that image file. If the latter is 
selected, the .icp styling file is saved in the same folder as the image file and uses the same base file name, 
without the format extension. 
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Stealth Mouse support in Stereo Analyst for IMAGINE 

Support is added for Stealth Mouse V-Type and Z-Type devices. This aligns Stereo Analyst’s Stealth Mouse 
support to the other viewplex-based stereo applications, namely Stereo Point Measurement tool (SPM), 
Terrain Editor(TE), ORIMA and PRO600.  

Three-Click Rotated Rectangle edit tool supported for vector layers (i.e., feature collection) 

The Three-Click Rotated Rectangle digitizing tool that was introduced with ERDAS IMAGINE 2022 Update 2 
has been enhanced to work with vector layers in addition to the previously supported Annotation and AOI 
layers.  
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Machine Learning Layout improvement to support Semantic Segmentation 

Collection of training data for Semantic Segmentation has been added to the Machine Learning Layout. The 
training data for Semantic Segmentation are image chips that are labeled at the pixel level. This means each 
pixel of the image chip is annotated (attributed) with the class it represents. The Machine Learning Layout 
provides a framework for digitizing/labeling different classes and generating the image chips based on the 
labels.  

 

Resample dialogs now use Spatial Modeler 

Resample dialogs (e.g., Raster tab > Geometry group > Geometric Calibration menu > Orthorectify without 
GCPs) have been reimplemented to replace the previous executable program with a Spatial Model. This 
produces several benefits, including significant improvement in performance and more consistent handling of 
NoData. 

Replacement Sensor Model (RSM) refinement support in IMAGINE Photogrammetry 

Support for refinement of RSM has been added. The RSM ground-to-image functions consist of one or 
multiple sets of rational polynomials that may have geometric errors. The geometric errors can be 
reduced/removed by applying polynomial corrections (refinements) to the original RSM model based on 
ground control points and tie points.  
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ERDAS IMAGINE LiveLink for Google Earth Engine 

Google Earth Engine is a combination of a planetary scale collection of geospatial data and massive compute 
capability that can change the way people approach geospatial information analysis. The holdings include all 
the imagery from programs like Landsat, MODIS, Sentinel and others. This imagery spans the Earth and in 
many cases covers the last 40 years. Coupled with this data is a rich geoprocessing engine that puts the 
processing close to the data in the cloud. The combination of data and processing makes it possible to 
perform actions such as mapping change over time for the whole world in ways that were impractical in the 
past.  

ERDAS IMAGINE LiveLink for Google Earth Engine is a new product available for use with ERDAS IMAGINE 
that pairs the intuitive, easy-to-use graphical modeling environment of ERDAS IMAGINE’s Spatial Model 
Editor with the vast data holdings and online geoprocessing capabilities of Google Earth Engine. 

 

The screenshot above shows a spatial-temporal query being used to select all the images within a 600-km 
radius of San Francisco in 2022, the NDVI computed for each, and all combined into a single output. Just 
locating and acquiring all this data would have been a large, time-consuming task in the past. 

LiveLink for Google Earth Engine introduces 12 new operators that provide the interface with the Google Earth 
Engine Cloud services. In addition to these 12, an additional 850 or so Earth Engine operators arranged in 
about a dozen categories are created dynamically within Spatial Modeler using Google Earth Engine’s REST 
API. These operators can be assembled like any other Spatial Modeler operator to create a model that runs on 
Google’s cloud infrastructure. 
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New interface Operators provided by LiveLink for Google Earth Engine 

Convert Image To Raster 

 

This operator uses the Earth Engine Image expression that is connected to the image port to create an 
IMAGINE.Raster on the output port. This enables raster tiles to be read by any of the Spatial Modeler 
operators that take an IMAGINE.Raster as an input. All the computation defined by the input Image expression 
is performed on the Google cloud infrastructure. Computation is only performed for the requested tiles at the 
requested resolution. 

Earth Engine Algorithm Input 

 

This operator is a section of the Spatial Model built from Earth Engine operators that is to be used as an input 
to an operator such as ImageCollection.map. The Algorithm must begin with an Earth Engine Algorithm Input 
that defines the number and order of inputs to be used. 

Evaluate Earth Engine Expression As Value 

 

This operator evaluates the Earth Engine Expression and returns its value as the appropriate type. For 

example, an expression that results in an integer will return an IMAGINE.Int on the output port, a double will 

return an IMAGINE.Double and a string will return an IMAGINE.String. Expressions evaluating non-value 
types such as an Earth Engine Image Collection or an Earth Engine Image return metadata about the 
expression as an IMAGINE.Dictionary. The JSON value returned from the expression evaluation can be 

viewed on the jsonOutput port. This can be useful during the development of the model to understand the 

results of an operation. 
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Export Image to Asset 

 

This operator lets you create a task to evaluate an Earth Engine Image expression and save the results as an 
asset in the Earth Engine Project space. Assets in the Project space can be directly used in further Earth 
Engine computations. The resulting asset ID is visible in the Project folder in the Earth Engine Catalog 
Browser. 

Export Image to Cloud Storage 

 

This operator lets you create a task to evaluate an Earth Engine Image expression and save it as one or more 
files in the named bucket in Google Cloud. The account to which the bucket belongs must have given access 
to the Earth Engine project being used. 
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Export Image to Drive 

 

This operator lets you create a task to evaluate an Earth Engine Image expression and save it as one or more 
files in the named folder in Google Drive. The account folder must be accessible to the Earth Engine project 
being used. 

Export Video to Cloud Storage 

 

This operator lets you create and start a task to evaluate and export an Earth Engine Image Collection 
expression as an MP4 formatted video file saved to Google Cloud storage. The collection must only contain 
RGB images in the final CRS and resolution. See Creating Videos From Image Collections for details. 

Export Video To Drive 
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This operator lets you create and start a task to evaluate and export an Earth Engine Image Collection 
expression as an MP4 formatted video file saved to Google Drive storage. The collection must only contain 
RGB images in the final CRS and resolution. See Creating Videos From Image Collections for details. 

Get Earth Engine Image Information 

  

This operator evaluates the Earth Engine Image expression given on the image port and returns several 
pieces of useful information about the first band of the resulting image. Earth Engine images are not 
constrained to have homogenous bands. The outputs dataType, dimensions, crs, bounds and center are 
presented for the first band only, given that typically the bands are homogenous; however, the full set of 
metadata is returned on the bandInformation port. 

This operator is very useful as a debugging tool during the development of a model using the Earth Engine 
image operators. 

Load Earth Engine Image 

 

This operator selects a single image from the Earth Engine catalog of data and makes it available as an 
EarthEngine.Image for use by any of the Earth Engine operators that take an EarthEngine.Image as an input.  

The operator can be configured using the Earth Engine Catalog Browser to select an image asset ID. 

Load Earth Engine Image Collection 

 

This operator selects an image collection from the Earth Engine catalog of data and makes it available as an 
EarthEngine.ImageCollection for use by any of the Earth Engine operators that take an 
EarthEngine.ImageCollection as an input.  
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The operator can be configured using the Earth Engine Catalog Browser to select an image collection asset 
ID. 

Wait For Operation 

 

This operator waits for the batch operation identified by the input to complete, and upon completion the final 
status of the operation is made available. 
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Issues resolved: ERDAS IMAGINE 2023  

IMAGINE Essentials 

Support ticket  Summary 

00137306 Problems opening and displaying some COSMO-Skymed Second Generation SAR images has been 
corrected. 

00140747 ERDAS IMAGINE would crash if 'Breakpoint Editor' was selected in the Help tab’s 'Search Commands 
window' after a raster image is displayed with the ‘Image Chain’ rendering engine. 

00091311 When displaying multi-band imagery using the legacy Raster rendering engine and attempting to use and 
save changes made using the Data Scaling tool, ERDAS IMAGINE would sometimes crash. 

 

IMAGINE Advantage 

Support ticket Summary  

00165651 Export Raster Product Format (RPF) was not writing Significant, Production and Currency Date attributes 
to the CADRG headers correctly. 

00022850 Occasionally, with some datasets, MosaicPro was introducing small gaps in seam areas between 
overlapping image frames. This has been corrected and should no longer occur.  

00106612 In previous versions of ERDAS IMAGINE it was not possible to drag the MosaicPro application window 
from the primary monitor to a secondary (or other) display. 

00091332 A customers specific set of imagery could not be successfully processed using MosaicPro. This has been 
corrected.  

00080609 MosaicPro was crashing during seamline generation when a specific TIFF file was sent to the top of the 
stacking order. The crash did not occur if this TIFF image was not moved to the top of the stacking order. 
The problem did not happen if you imported the TIFF file to IMG format and replaced it in the 
photogrammetric project. This has been corrected. 

00059579 Certain customer data, loaded in a specific order into MosaicPro could cause a crash when mosaicking. 
This has been corrected.  

00023137 When mosaicking specific panchromatic images in JPEG 2000 format and writing the output to JPEG 
2000 format the mosaicked image might contain several black 512 pixel x 512 pixel squares. The black 
squares had a pixel value equal to 1. The problem did not happen when writing the output to IMG or ECW 
format. 

00091994 Attempting to orthorectify some NITF images to a GeoTIFF output file would fail with an “Invalid 
arguments” message. This has been addressed by moving the resampling processes to use Spatial 
Modeler.  
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IMAGINE Expansion Pack 

Support ticket Summary  

00023261 When resampling data in AutoSync the map and projection information from the input raster wasn’t being 
written directly to the JPEG 2000 format output image. Spatial information was written to the associated 
.aux file instead. This could be an issue when the JP2 raster is used outside of the ERDAS IMAGINE 
environment (e.g. ArcGIS). This is related to IM-55223: “Map coordinate and projection information isn’t 
written to output JPEG 2000 image,” which fixed the problem in other areas of ERDAS IMAGINE (e.g. 
MosaicPro, Subset, etc.) but the issue remained when outputting JPEG 2000 data from AutoSync. 

 

IMAGINE SAR Interferometry 

Support ticket Summary  

00099763 Documentation issues relating to the Differential InSAR input step have been corrected. 

IMAGINE SAR Feature 

Support ticket Summary  

00108773 The Radar Image Chain now correctly disallows changing the resampling method, while other Image 
Chains (such as Panchromatic) allow the resampling method to be selected and correctly applied to SAR 
imagery.  

 

IMAGINE Photogrammetry 

Support ticket Summary  

00065305 With the introduction of IMAGINE Photogrammetry 2022 Update 1 contrast adjustment had the effect of 
blacking out imagery with a dynamic range greater than 8-bit. This occurred when using Photogrammetry 
> Classic Point Measurement > (Right click) > General Contrast. 

00151158 When an ISAT Project was imported into an IMAGINE Photogrammetry project the Exterior Orientation 
angle units were incorrectly translated and were always changed from angular degrees to radians. 

00154591 The button mapping file was missing for the 3D Softmouse input device. 

 

IMAGINE DSM Extractor 

Support ticket Summary  

00063859 The IMAGINE DSM Extractor process could fail to execute correctly using some specific datasets. 

00048344 When using input images with irregular boundaries (e.g. study-area AOIs) the DSM extraction process 
could sometimes fail to complete.  

IMAGINE Professional 
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Support ticket Summary  

00023382 The Grid Generation Tool was producing an empty shapefile on systems where the Japanese system 
locale was set. 

00023228 The Machine Learning Layout was failing to load Object Footprints With Image Chips 

ERDAS ER Mapper 

Support ticket Summary  

00034079 ERDAS ER Mapper was failing to write output file from an algorithm if the target format was JPEG 2000 

00023194 ERDAS ER Mapper was writing the wrong datum and projection for GDA2020 

 

IMAGINE Objective 

Support ticket Summary  

00023502 Occasionally IMAGINE Objective might crash after selecting ‘Accept’ to save training in projects with 
multiple Raster Pixel Processor cue metrics (e.g. SFP, Identity) using different project raster variables. 

00023501 IMAGINE Objective project would generate unexpected ROC Segmentation results from RPP Identity 
metric if the input data were Float (rather than u8 or u16.) 

00023236 The Raster Pixel Processor pixel cue probability layer required for the ROC “Line Threshold and Clump” 
plug-in layer could not be generated in IMAGINE Objective. Consequently “Line Threshold and Clump” 
has been removed from the software to avoid confusion. 

00023238 The IMAGINE Objective VOP cue would sometimes not save projection parameters to the output 
shapefile. 

Spatial Modeler  

Support ticket Summary  

00084429 Creating image chips with the Create Dice Boundaries operator in combination with Define Processing 
Area and Iterator operators would sometimes fail. It was correlated to the number of image chips being 
produced in parallel. When using 512x512 pixels for each chip it worked. But choosing 224x224 pixels it 
failed. Then ERDAS IMAGINE might crash if you attempt to close the Spatial Model Editor by clicking the 
X in the upper-right corner. 
 
The process should no longer cause a crash and should complete successfully in most cases.  

00115281 The Raster Statistics per Feature operator could, under certain circumstances, return incorrect 
(frequently 0) ComputeSum statistics. 

00086755 
00100698 

With some input datasets the Convert To Features operator could cause the error “Trying to change a 
running meter from modal to non-modal is not supported!” to be reported. After closing the error window 
ERDAS IMAGINE would remain frozen and needed to be restarted, but the output feature data was 
created correctly.  

00086713 The Convert to Raster operator could sometimes fail to convert some large polygons or islands 
associated with multi-polygons (resulting in NoData pixels instead.) 

00130377 When producing multiple Features sets inside an Iterator and passing that List of Features to an operator 
such as Union Features a crash could occur. 

00132145 The Initialize Image Segmenter operator was failing to run successfully if raster with more than 3 bands 
was passed in.  
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00112336 The Add Attributes By Location operator could return empty attribute fields when working with 
Geopackage vector data. 

00090607 Deep Learning Object Detection was creating much worse result from classification if using training data 
based on using the "Image Chips With Footprints" method compared to "Footprints only." 
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About Hexagon 
Hexagon is the global leader in digital reality solutions, combining sensor, software and autonomous 
technologies. We are putting data to work to boost efficiency, productivity, quality and safety across industrial, 
manufacturing, infrastructure, public sector, and mobility applications. 

Our technologies are shaping production and people-related ecosystems to become increasingly connected 
and autonomous – ensuring a scalable, sustainable future. 

Hexagon’s Safety, Infrastructure & Geospatial division improves the resilience and sustainability of the world’s 
critical services and infrastructure. Our solutions turn complex data about people, places and assets into 
meaningful information and capabilities for better, faster decision-making in public safety, utilities, defense, 
transportation and government. 

Hexagon (Nasdaq Stockholm: HEXA B) has approximately 24,000 employees in 50 countries and net sales of 
approximately 5.2bn EUR. Learn more at hexagon.com and follow us @HexagonAB. 

 

 

Copyright  

© 2024 Hexagon AB and/or its subsidiaries and affiliates. All rights reserved. All other trademarks or service 
marks used herein are property of their respective owners.  

Warning:  The product made the subject of this documentation, including the computer program, icons, 
graphical symbols, file formats, audio-visual displays and documentation (including this documentation) 
(collectively, the “Subject Product”) may be used only as permitted under the applicable software license 
agreement, and subject to all limitations and terms applicable to use of the Subject Product therein. The 
Subject Product contains confidential and proprietary information of Intergraph Corporation, a member of the 
Hexagon Group of companies (“Hexagon”), its affiliates, and/or third parties.  As such, the Subject Product is 
protected by patent, trademark, copyright and/or trade secret law and may not be transferred, assigned, 
provided, or otherwise made available to any third party in violation of applicable terms and conditions cited 
further below. 

Terms of Use 

By installing, copying, downloading, accessing, viewing, or otherwise using the Subject Product, you agree to 
be bound by the terms of the EULA found here:  https://legaldocs.hexagon.com/sig/Licenses/EULA_SA_SIG-
Eng_062023.pdf. 

Disclaimers 

Hexagon and its suppliers believe the information in this publication is accurate as of its publication date. 
Hexagon is not responsible for any error that may appear in this document. The information and the software 
discussed in this document are subject to change without notice. 

Language Translation Disclaimer:  The official version of the Documentation is in English. Any translation of 
this document into a language other than English is not an official version and has been provided for 
convenience only. Some portions of a translation may have been created using machine translation. Any 
translation is provided “as is.” Any discrepancies or differences occurring in a translation versus the official 
English version are not binding and have no legal effect for compliance or enforcement purposes. Hexagon 
disclaims any and all warranties, whether express or implied, as to the accuracy of any translation. 

https://twitter.com/hexagonab
https://legaldocs.hexagon.com/sig/Licenses/EULA_SA_SIG-Eng_062023.pdf
https://legaldocs.hexagon.com/sig/Licenses/EULA_SA_SIG-Eng_062023.pdf
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Reasonable efforts have been made to provide an accurate translation; however, no translation, whether 
automated or provided by human translators is perfect. If any questions arise related to the accuracy of the 
information contained in a translated version of Documentation, please refer to its official English version. 
Additionally, some text, graphics, PDF documents, and/or other accompanying material may not have been 
translated. 

Links To Third Party Websites 
This Document may provide links to third party websites for your convenience and information. Third party 
websites will be governed by their own terms and conditions. Hexagon does not endorse companies or 
products to which it links. 

Third party websites are owned and operated by independent parties over which Hexagon has no control. 
Hexagon shall not have any liability resulting from your use of the third party website. Any link you make to or 
from the third party website will be at your own risk and any information you share with the third party website 
will be subject to the terms of the third party website, including those relating to confidentiality, data privacy, 
and security. 

Hexagon provides access to Hexagon international data and, therefore, may contain references or cross 
references to Hexagon products, programs and services that are not announced in your country. These 
references do not imply that Hexagon intends to announce such products, programs or services in your 
country. 

 

Revisions 
Hexagon reserves the right to revise these Terms at any time. You are responsible for regularly reviewing 
these Terms. Your continued use of this Document after the effective date of such changes constitutes your 
acceptance of and agreement to such changes. 

Questions 
Contact us with any questions regarding these Terms. 

 

 

https://hexagon.com/company/contact-us
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